RAITH e-LiNE Step-by-Step Operation Instructions
written by Madalina Colci O'Hara
Department of Physics, University of Illinois

1. Logbook and prechecks
   Check the logbook to make sure there is no problem with the SEM and nobody is using the system.

2. Start the System
   There are two computers: first one, next to the stack of electronics that control the system, is the Lithography PC (LPC); to the right of it is the Column PC (CPC).
   On CPC:
   - Start the SmartSEM program. The RemCon32 program must be running in the background.
   - Read pressure in the column using the SEM Control window which is popped up via Tools → Go To → Control Panel (or, on top toolbar, third icon from the right). Choose Vacuum tab. Should read low $10^{-9}$.
   On LPC:
   - Start the Raith e_LiNE program. Always do this only after the SmartSEM program has started.

3. Sample preparation
   - Put on gloves. Gloves must be worn when handling samples and the sample holder. Also, do not touch the transfer rod with bare hands!
   - Samples must be clean and dry, i.e., free of moisture, oils and grease that could contaminate the vacuum system.
   - Make a small scratch on what you want to be the lower left corner of your sample (see drawing on last page). Blow away residue with the nitrogen blower.
   - Place sample on sample holder with plastic tweezers. Don’t scratch the sample holder.
   - Write down the clip number where you put your sample(s). Clips are numbered from 1 to 6 from left to right; there are two other clips, 7&8 – see drawing on last page.

4. Sample Holder Loading
   The sample holder is inserted into the chamber via the airlock at the left side of the system.
   - Fit the sample holder securely on the transfer rod
   - Close the door and lock it with the clamping screw at the left in order for the airlock to be tight when pumping it down.
   On LPC:
   - Load sample using Navigator Exchange (2nd stop light icon on toolbar).
   - Choose “via Loadlock” loading. Tighten the clamping screw again after pumping started.
   - Follow instructions on computer screen.
   To open gate valve, pull top screw and rotate lock counterclockwise, then pull the rod. When closing the gate valve, insert rod completely & rotate lock fully clockwise. If top screw didn’t fall in place then rotate counterclockwise a bit.
   - At the end of load procedure, choose the high voltage and aperture size at which writing will be done. Common values: HV = 10 kV, Aperture = 30 µm, Working distance (WD) = 10 mm.

5. Setting the Working Distance
   On LPC: In Stage Control window, Command tab, select pre-saved position Faraday Cup on holder. Click GO.
   When stage reached position, un-blank the beam using appropriate toolbar icon.
   On CPC: Start scanning by pressing the scan icon on top toolbar. Use a low magnification (e.g., x70).
   In Control Panel window, Detectors tab: Adjust Brightness and Contrast to get a good image.
Focus: select Coarse focus by clicking with left mouse button on bottom toolbar. Press and keep pressed the thumb mouse button while moving the mouse left-right to adjust. Do the same for Fine focus.

On LPC:
- In AdjustUVW window, select Adjust W tab.
- Press Read W button when image is focused.
- Then press Adjust. Now W will be equal to WD.
- In Stage Control window, choose Destination tab
- Set W = 10 mm. Make sure “absolute” (not “relative”) is selected. Click “Start”.
- On CPC: bottom toolbar, double-click WD and set WD = 10.
- Wait while the stage is raised to WD = 10 mm.

While at the Faraday, measure beam current:
On CPC:
- center on the cup with the crosshairs
- zoom in to ~ 20K
- thumb-click on Spot icon on top toolbar (2nd icon from the right)
- on LPC, in Current window, click Measure
- thumb-click on Spot icon again to resume the scan

6. Setup of Global UV Coordinate System

On CPC: Find the lower left corner of the chip. Put it in the center of the crosshairs.
On LPC:
- In Adjust UVW window, select Origin Correction tab.
- Press Adjust button. This will assign the UV coordinate (0,0) to the current XY stage position.
- Select the Angle Correction tab.
- Press Read to save this location as point 1
- Without changing the magnification, drive stage to lower right corner of sample. Put that corner in the center of the crosshairs.
- Press Read to save this location as point 2
- Press Adjust button. This will calculate the transformation angle between XY and UV coordinate systems.

Note: the computer assumes +U direction along the vector from point 1 to point 2.

7. Tuning the SEM

Adjust Focus
On LPC:
- In Stage Control window, Command tab, go to the pre-saved position of the clip where the sample is. The image that you see is the right side of your chip clamped by the clip.

On CPC:
- Using the joystick, drive to the lower left corner.
- Increase magnification (30K – 60 K) and find a speck to focus on. Put it in the center of the screen using the crosshairs.
- Adjust focus for sharpest possible image. Activate scanning of only a small part of the screen using “Reduced Raster” icon on toolbar. This way one gets a faster update rate to make the adjustments easier.

Adjust Aperture (on CPC)
- Go to Control Panel window, Scanning tab.
- Choose scanning speed 3.
- Go to Apertures tab.
- Activate button Aperture Align; positioning window gets the heading "Aperture Align".
- Activate **Focus Wobble** and set a **Wobble Amplitude** (start with 5%, increase up to 20%). Now the focus is changed through optimal focus periodically. Apart from astigmatism effects, the objects within the scanning window will be shifted back and forth in some direction. The goal of this adjustment is to make this shift as small as possible, i.e., the objects should appear stationary within the scanning window. There will be some effect from astigmatism - the fuzziness of the objects is going in different directions during the focus-wobbling period.
  - Adjustments can be done several ways:
    - **Coarse method:** clicking left mouse button (LB) and dragging the red dot inside positioning window.
    - **Fine method:** clicking on the left/right and up/down arrows at the edges of the positioning window.
    - **Finest method:** clicking and dragging left mouse button on the scanned image. The mouse can be moved both left-right and up-down.

In all three cases the red dot will indicate the adjusted position. The "zero" position of the red dot doesn't mean anything; the window is there just to help you visualize how much you changed settings. When the speck/mark is as still as possible (just going in and out of focus):
    - Switch off **Focus Wobble** and click on **Mag/Focus** button.

**Adjust Stigmatism** (on CPC)

The astigmatism is adjusted in a similar way to the Aperture Align:
  - Activate button **Stigmation**
  - Use the **Finest** method above.
  - Adjustments of stigmatism and focus are interdependent. For each adjustment of the stigmatism, the focus should be readjusted. The focus adjustment is still done using middle mouse button.

**Note:**
A common mistake is to want to change the magnification while still in stigmatism or aperture adjustment mode. Always check on the bottom toolbar on CPC which function of left mouse button is selected before changing the magnification during this procedure!

**Burning a Contamination Dot** (on CPC)

In order to further fine-tune the stigmatism & focus it is necessary to get a smaller spec to look at. One way to do this is to burn a contamination dot in the resist. Parking the e-beam for several seconds in the scanning field will accomplish this.
  - Increase magnification to > 70,000
  - Press toolbar function button for spot – 2\textsuperscript{nd} icon from the right:
    - Clicking on the icon with left mouse button gives 3-second burn
    - Thumb-click keeps beam on the spot as long as desired, until button is thumb-clicked again.
  - The burned dot can now be used for further adjustments. The adjustments should always aim for both maximum sharpness and maximum roundness of the contamination dot.

8. **Write-field Alignment**

**CASE A – for un-patterned samples**

Write-field (WF) alignment is the adjustment of the electromagnetic/electrostatic deflection system inside the column to the high precision X-Y-Z stage for a given combination of magnification & write-field setting of the microscope. From the difference between the detected position and ideal position, software calculates scaling, shift and rotation of write-field. The stage travel distance is considered to be an accurate displacement, and the e-beam deflection system is aligned to it.

On **CPC**: Select an easily recognizable feature, like a speck of dirt or PMMA, as a mark on the sample. Position it in the center of the screen using the crosshairs.
Adjust Brightness and Contrast to get a good image.
On **LPC:**

a. Blank the beam  
b. Go to *File* menu. Open *New positionlist*  
c. In *Microscope Control* window, select or create the desired pair (magnification, field size)  
   Example: x1000 for 100 µm field size  
   Click on *Save*, then *Set*. This way the setting is transferred to the column  
d. In *Scan Manager* window, select *Align Write Field Procedure*, then *Manual*  
   Double-click on desired alignment template (or right-click and select *Properties*).  
   In *Main* tab: select a *Scan size* and *No of Points*. Use *Calculator* icon to adjust *Step size*.  
   For a newly defined WF it is recommended to start with *Scan Field* sizes as large as possible.  
   Example: for 100 µm WF, start with 50 µm *Scan size. No. of points* can be 500.  
   In *Mark Procedure* tab: – select mark sequence (at least three marks).  
   – enable the auto-placement function by pressing the *Placement* icon.  
   The software will now place the scan fields automatically as far as possible into the corners of the write field. For the above example, this displacement will be 24.9 µm from WF center.  
e. Drag and drop this Align WF procedure into the Positionlist.  
f. Right-click on the line in the Positionlist and select *Scan*.  

The stage moves 24.9 µm (the value in *Placement*) in U and in V to the first corner. Here the beam is scanning the *Scan Field* area selected in the alignment template (50 µm in the above example).

- At each position the operator is presented with the scanned image. A green cross shows the position where the system thinks the mark is.  
- Hold *CTRL key*, press *left mouse button*, and drag the mouse cursor to identify the speck each time it is scanned. A blue cross is displayed after releasing the CTRL key.  
- The new position of the speck is taken as a "corrective" position.  
- When all three or four marks in the sequence have been scanned, correction parameters are computed and you are asked: “Accept the write field correction?” If you think you made a mistake when selecting your speck in the scanned images, don’t accept the correction and start over.  
- After accepting the correction: in *Microscope Control* window, click *Save* to save the correction in the database  
- Check Protocol file -Internet Explorer on Windows taskbar -for convergence of parameters  

Repeat steps d, e, and f with sequentially smaller scan sizes. Final scan size should be < 1% of the WF size (e.g., 1 µm *Scan Field* for 100 µm WF). The green cross should gradually appear closer to (or even right on) the speck.  
g. Automatic WF alignment using images: In *Scan Manager* window, select *Align Write Field Procedures*, then *Automatic with images*. Do steps d, e, f above for 1 µm *Scan size*.  

The alignment parameters will be saved together with the magnification and the field size. Whenever you call up this setting again, the correct field alignment will have been stored and you should only need to perform small scan field correction (10 µm, 5 µm and 1 µm).
CASE B – for patterned samples

I. Calculate coordinate transformation $XY \rightarrow UV$. This will link $XY$ coordinates of the chip to the $UV$ coordinates of GDSII design. Use three marks, preferably in the shape of a cross.

- Set MAG to a high value (e.g. x 10K) to avoid exposing critical areas.
- Find your alignment marks, either by using the joystick to drive where first mark is expected to be, or by typing $(X, Y)$ position in $Destination$ tab of $Stage Control$ window if you know it.
- Center on mark with crosshairs, and then blank the beam
- In $Adjust UVW$ window, select $3-Points Adjustment$ tab.
- Press Read button to capture $XY$ coordinates of current stage position. Then do one of the following:
  1. Type in the $UV$ design coordinates of the first adjustment mark in $mm$ (not $\mu m$!). Read these from your pattern.
  2. Open the design pattern and the “Tools” menu. Select Flag #1 and drop it on the center of your alignment mark in the pattern. Then, in $Adjust UVW$ window, $3-Points Adjustment$ tab, press Read button again.
- Check the box corresponding to point 1 to “lock” the $XY$ and $UV$ coordinate pairs.
- Repeat the above sequence for the other two marks: locate mark with crosshair, Read $XY$, type/flag $UV$, then click check-box. If you want to drive the stage to another mark using the relative distance between them: In $Stage Control$ window, $Destination$ tab, select UVW base and “relative”. Then enter the distance and click “GO”.
- When all three marks have been “locked”:
- Press Adjust button. This calculates coordinate transformation $XY \rightarrow UV$. Stage now drives in the coordinate space defined by the marks that are on the sample.
- If you hold $CTRL$ key and right-click on a feature in GDSII pattern, stage will drive there.

II. Align Writefield to alignment marks on your sample

- Set system to desired Writefield size and magnification
- Drag-and-drop GDSII pattern into the Positionlist. Right click and select “Properties”.
- Select only layer 63, set working area, auto-placement, exposure parameters
- Scan position and manually correct the alignment. During this procedure, the stage is stationary, and the beam is deflected to the corners of the WF.
- Change layer to 61 (automatic marks) if you have designed them on top of your manual marks.
- Scan once more - use automatic WF alignment using mark detection. Open the ALIGN.PLS Positionlist (in folder "Data") to verify line scans and threshold algorithm for proper mark recognition.
- Check Protocol file for convergence of parameters. Repeat last step as many times as desired to increase accuracy

9. Exposure

- Open a new Positionlist: File $\rightarrow$ New positionlist.
- Drag-and-drop the corresponding design(s) from the GDSII Database into Positionlist.
- Right-click the position and select Properties
- Use Layer button to select desired layers to expose.
- Use Working Area button to select pre-defined area to expose.
- Type in $UV$ coordinates corresponding to center of the first WF. If you used alignment marks, simply press right button below working area button; this will automatically set the center of the selected working area.
- Press Exposure Parameter button to adjust exposure parameters.
- Use Calculator button to display window for adjusting current, step size, dwell time and dose.
- Set the desired step size and dose, and use calculator icon for dwell time. Setting these parameters here overrides anything set in the Exposure window.
- One can also perform a time estimation of the exposure using the Times button.
- Start exposure: right-click the Positionlist line and select Scan.

10. Unload sample

- Unload sample using Navigator Exchange on the lithography PC (2nd stop light icon on toolbar).
  - Follow instructions on screen.
- Exit Raith e_LiNE program on the lithography PC: File → Exit.
- Log out of SmartSEM program on the column PC: File → Log out.

Troubleshooting:

1. If no image on screen after finished loading, check the following things:
   - On LPC: beam is unblanked
   - On CPC: a. Scan mode is active (not Chamberscope view)
     - b. Control Panel, Apertures tab: check if beam is un-blanked
     - c. Set Magnification to < 100
     - d. Control Panel, Detectors tab: adjust Contrast/Brightness

2. Write-field alignment: If no mark shows up when scanning, confirm the Continue prompt without making corrections. Choose a larger mark size or larger scan field size, and try again.

3. If your choice of magnification & field size parameters in Microscope Control window is not compatible, you'll get a Warning at the end of the write-field alignment that says, for example: "Zoom X: 1.6785 is greater then 1. Please reduce magnification setting at column". Reduce the magnification and try again until it accepts your combination of Magnification & Field size.

Comments:

1. Align Writefield parameters:
   - Zoom U & V: adjusts the real size of a structure
   - Shift U&V = shift with respect to U and V axis; offset of beam center with respect to a point in UV; important for overlay exposure.
   - Rotation U&V = rotation of beam major axes with respect to U&V. These values are responsible for the correct orientation of the beam movement relative to sample coordinate system.

2. Stigmatism - condition of an optical system (as a lens) in which light rays from a single point converge in a single focal point. Stigmatism distortions refer to defects in an optical system in which light rays from a single point fail to converge in a single focal point. Astigmatism results in the beam shape being elliptical instead of round. When alternating between over and under focus, astigmatism can be recognized by a smeared image in two different directions.

3. Exposure parameters: there are several parameters important for correct ebeaming of small features. They are found in Exposure window on LPC, under Details tab. One of them is the Exposure Raster. Select Free metric raster, and choose a “Basic step size”. Choose this value based on the size of your features. You want the basic step size to be a factor of your feature size.
   - For example, if you have 100 nm lines, choose basic step size to be 5 nm or 10 nm. If you choose it to be 15 nm, for example, then the beam will make 6 or 7 passes along your line to fill it (100/15=6.66), so your feature will either be a bit smaller or a bit larger than what you want. The biggest downside of this factoring is that your edges might be ragged because the beam “didn’t know what to do”.
4. When using alignment marks in your pattern:
   – Do a write-field alignment of a **CASE A**–type (for un-patterned samples) using one of your small alignment marks (as opposed to using a speck of dirt on your sample). This will ensure that the beam scan is parallel to the pattern you have on the chip. Using only Layer 63 alignment procedure won’t give best results.
   – Once you’ve done the last write-field alignment (layer 63) to your align marks, **DO NOT MOVE STAGE** anywhere if you need very precise alignment (< 100 nm). Just select the layers and parameters for exposure, and expose. If you move the stage, it won’t come back to the exact coordinates.

Sample Holder Raith e-line

![Sample Holder Diagram](image-url)